Arial Wireless Emergency Call Solution

2. Once the reset button has been pressed, the red light will stop blinking .

Reset
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Specifications: Arial Pendant 2560-59350

Physical and Mechanical

Dimensions: 1.9 x 2.2 x 0.72 ” (4.8 x 5.6 x 1.8 cm)
Weight: 1.2 0z. (35 g)
Mounting: Neck cord and belt clip provided

Output Frequency

900MHz Spread Spectrum

Power

3V CR2-type lithium battery (Panasonic, Sanyo
or approved equivalent)

Battery Life

1— 2 years, if operating temp. 68-86° F (20-30° C)

Environmental

Operating temperature: 0°C to 49°C (32°F to
120°F)

Humidity: O to 93%, non-condensing

Certification and
Regulatory Compliance

UL2560

Models 2560-59360/59361/59362 — Small Pendant

Pendant LEDs

ALARM ACTIVATION ALARM CLEARANCE

(Red) (Blue)

When activated, Light flashes blue
pendant vibrates when magnetic card
briefly and light is used or button
flashes red until pattern is pressed.

alarm is cleared.
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LOW BATTERY
(Yellow)

Light blinks yellow
to notify residents
and staff.

45




Arial Wireless Emergency Call Solution

How to Use the Small Pendant:
Sending an Alarm

JEEN

Press the Activation button for at least one second.

2. When activated, the pendant vibrates briefly and the red transmission LED
blinks rapidly for the first five seconds, and then slowly until the alarm is
cleared.

3. Ifthe red light does not flash, the call has not been sent. The pendant’s battery

may need to be replaced.

Activation
button

h_

Clearing Alarms
There are two ways to clear the alarm:

1. Button Press Pattern
2. Magnetic Card

Button Press Pattern
1. Press the Activation button three times, quickly.
2. When the blue LED flashes twice, press the Activation button three more times,
quickly.
3. The blue alarm LED flashes quickly six times indicating the alarm has been
cleared.

Magnetic Card
1. Place the dot on the ACC680 Alarm Clearance Card over the Activation button.
2. The red LED ceases flashing and the blue LED flashes quickly six times
indicating the alarm has been cleared.

Installing the Battery
If the red light does not flash when you press the alarm button, the pendant’s battery
will need to be replaced. The battery must only be replaced by a staff member who is
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properly trained to work with Arial pendants. The Arial pendant uses a Panasonic 3V
lithium CR2032 battery.

Follow these steps to install or change the battery:

1. Use the ACC680 Alarm Clearance Card or a quarter to turn the battery door to

the unlocked padlock icon.

Unlocked
position

N

Remove the battery door.
3. Remove the old battery from the battery compartment.
4. Place the new battery in the battery compartment, ensuring that the positive
terminal (+) faces up.
5. Seat the battery door over the battery so that the arrow on the battery door is
lined up with the unlocked padlock icon.
6. Use the ACC680 Alarm Clearance Card or a quarter to turn the battery door to
line up the arrow on the battery door with the arrow under the locked padlock
icon.
Locked

position
s

7. Press the Activation button on the front of the pendant to initialize the

transmitter.
8. Clear the resulting alarm.

Storage Mode

Storage mode is an ultra-low battery state designed to protect the life of the
internal backup battery. The pendant is shipped in storage mode. If the water-
resistant pendant transmitter will go unused for any significant period, it should be
put in storage mode. The pendant will also automatically go into storage mode at
the next check-in transmission time if the coin cell battery has been removed.

Note: When the pendant is in storage mode, it will not transmit alarms or
check-in messages.

Extended Storage Requirements

If the pendant will be in storage for a time that may reach or exceed 12 months, the
coin cell battery must be installed in the pendant. Extended storage of the pendant
without the coin cell battery or with a dead coin cell battery can cause the pendant
to become unusable even if a new coin cell battery is installed. There is no
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recovery for the pendant once this occurs and the pendant cannot be repaired.
When a new coin cell battery is installed in the pendant, the pendant can be stored
for a period of up to approximately three years (assuming no alarms are placed).
The coin cell battery must be replaced again at either the three-year point or when
the coin cell battery becomes low (whichever occurs first) should storage need to
be further extended.

When stored with the coin cell battery, the pendant will transmit regular
supervision signals that will help your facility manage the pendant while it is in
storage. A best practice is to register the pendant to the Arial system using room
and description information to help identify the pendant as a stored pendant.
Adding the transmitter ID number (labeled as “TX ID: ########” on the back of
the pendant) to the description can help staff later identify the pendant should it
accidentally be set into alarm or need the battery replaced again. When the
pendants are registered to Arial, staff will see Low Battery Alerts for the stored
pendants when the coin cell batteries become low and need to be replaced.

Putting the Pendant in Storage Mode

Note: The pendant should not be left in storage mode for more than 12
months, or they may become unusable. Pendants should be stored in
ambient conditions (69 to 73 degrees Fahrenheit/ 20.5 to 22.8 degrees
Celsius).

1. Use the ACC680 Alarm Clearance Card or a quarter to turn the battery door to

the unlocked position.

Remove the battery from the battery compartment.

Press the Activation button for at least one second. The red LED flashes and

the pendant vibrates briefly to indicate that an alarm has been sent. This serves

as confirmation that the pendant is now in storage mode.

4. Seat the battery door over the empty battery chamber and use the ACC680
Alarm Clearance Card or a quarter to turn the battery door to line up the arrow
on the battery door with the arrow under the locked padlock icon.

wN

Note: If the alarm Activation button is pressed when the pendant is in
storage mode and the battery is not installed, a yellow LED illuminates
briefly on the lower portion of the pendant to indicate a missing battery
condition to the user.

Taking the Pendant out of Storage Mode
1. Use the ACC680 Alarm Clearance Card or a quarter to turn the battery door to
the unlocked padlock icon.
2. Remove the battery door.
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3. Place a battery in the battery compartment, ensuring that the positive terminal
(+) faces up.

4. Seat the battery door over the battery so that the arrow on the battery door is
lined up with the unlocked padlock icon.

5. Use the ACC680 Alarm Clearance Card or a quarter to turn the battery door to
line up the arrow on the battery door with the arrow under the locked padlock
icon.

6. Press the Activation button for at least one second. The red LED flashes and
the pendant vibrates briefly to indicate that an alarm has been sent. This serves
as confirmation that the pendant is no longer in storage mode.

7. Clear the alarm sent when you activated the pendant.

Important! If the pendant has been in Storage Mode for more than six
months, the coin cell battery should be installed at least 72 hours prior to
giving the pendant to a resident to use. This is necessary to allow the
internal battery in the pendant to charge sufficiently.

Testing the Pendant
The pendant should be tested after registration and then weekly to ensure optimal
operation.

To test the pendant:

1. Press the Activation button for at least one second and ensure the red LED
lights, the vibration activates, and the alarm is received by the receiver or
gateway.

2. Clear the alarm and ensure the red LED stops flashing, and the blue LED
flashes.

Specifications: Arial Pendant 2560-59360/59361/59362

Physical and Mechanical Weight: 0.6 0z (17 g)
Environmental Operating temperature: 0°C to 49°C (32°F to
120°F)

Humidity: O to 93%, non-condensing

Battery 3V lithium Panasonic CR2032 Battery is always
supervised.

Battery Life: 1 year typical

Frequency 902-928 MHz, frequency hopping spread
spectrum
Certification and UL2560

Regulatory Compliance
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Supplemental Hardware Components

The supplemental hardware components may already exist in a facility from a
previous Arial deployment or can be optionally added.

The following supplemental components are described in this section:
e Display Sign
e Paging Base Station
e Avrial Pager

NOTE: Serial devices such as paging transmitters and LED display signs
may be connected to the Arial nurse call network using a 2560-54312
Network Manager. A second network interface card is provided with the
server PC in the 2560-54322 bundile for the purpose of connecting the
Arial 900MHz Wireless Call System to a different network (such as the
facility network) in order to communicate with other supplemental devices
or third-party systems and applications.

WARNING! — EQUIPMENT THAT IS CONNECTED TO THE SYSTEM IS NOT
CONSIDERED TO BE PART OF THE LISTED SYSTEM CONFIGURATION
UNLESS THE EQUIPMENT IN QUESTION COMPLIES WITH THE STANDARD
FOR EMERGENCY CALL SYSTEMS FOR ASSISTED LIVING AND
INDEPENDENT LIVING FACILITIES, UL 2560.

Display Sign

Model Comments / Version

SKU: 54140 Networked Display Sign

The remote display gives staff the ability to view emergency calls while going about
their normal care routine. When a resident summons for help, remote displays provide
programmable information about the resident’s apartment number, name and/or the
device type used to call for help. Messages are cleared automatically when staff
members respond to a call. Remote notification options help to maximize staff
efficiency and speed staff response time. Due to their high visibility, they can be
considered the equivalent to lights above doors in skilled nursing facilities.

Signs have three colors (red, green, and amber) and sixteen scroll modes. The Event
Categories features of Arial are used to make different types of alarms appear in
different colors. Escalation (which is setup in the ‘Zone’ area of the software) causes
messages on the signs to change to a different scroll mode to indicate that the alarm
has been going off longer than newer alarms on the sign.
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Signs connect to Arial via a network connection and an IP to RS232 converter located
at the sign. One-off messages can be sent manually from the software to an individual
sign or pager at any time.

Signs may be mounted on a ceiling, wall or a flat work surface using the included
hardware.

Figure 27. Display Sign

Specifications: Display Sign
Physical and Mechanical Dimensions: 28.9” x 3.3” x 4.5” (73.5 x 8.4 x 11.5
cm)

Display Dimensions: 2.1” x 27” (5.3 x 68.5 cm),
Character size 2.1” (5.3 cm

Weight: 6.25 Ibs. (2.8 kg), includes display and
external power supply

Power 120 VAC+ 10% (Optional 220 VAC)

Characters Displayed 15 maximum (single line)

Message Capacity 26 different messages can be stored and
displayed

Certification and Regulatory UL2560

Compliance

Paging Base Station

Model Comments / Version

SKU: 0900-353 Paging System
(WaveWare SPS-5)

The Paging Transmitter is a completely self-contained compact integrated POCSAG Paging
System. The system, which is comprised of a digital paging transmitter and embedded
paging encoder, is supplied with Windows® based encoder configuration software.
Connections between the PC and the SPS-5 Paging System are supported via a standard
(supplied) RS-232 cable.
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WaveWaré

SPS:”

PAGING SYSTEM

Figure 28. Paging Base Station

Physical and Mechanical

Dimensions: 9.0"H x 8.5"W x 2"D

Weight: Approximately 1.5 Ib

RS-232 Serial Com Ports

Single

Paging Message Types

POCSAG Tone/Vibrate, Numeric and Alphanumeric

RF Data Rate

512, 1200, and 2400 bps Auto-switching

Pager Database

5,000 PLUS, EEPROM

Interface Protocols

TAP, COMP1, COMP2, SCOPE or WAVEWARE
proprietary

Serial Port Configuration

300, 1200, 2400, 9600 Baud, Even/No parity, 7/8
data bits

Frequency

Frequency Source: Synthesizer
Frequencies: UHF2 - 440-470 MHz (US)

Frequency Stability: +/- 2.5 ppm

Operation Rating

Intermittent, 66% duty cycle

Power

Power Supply: 2VDC 3.75A AC/DC Adapter

Power Out (watts): 2 Watts (US)

Environmental

Temperature: 0 to 28° C (32 1o 82° F)

Modulation

+/- 4 kHz (Wideband) or (Narrowband)

Bandwidth

Wideband (25 kHz) or Narrowband (12.5 kHz)
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Transmitter FCC ID UHF — MMASD225U2
Certification and Regulatory UL2560
Compliance

Arial Pager
Model Comments / Version
SKU: 52112 Arial Pager
(Apollo AL924)

The Arial Pager is an alphanumeric device with a multi-line display and a zoom feature. Belt clip,
lanyard, safety chain and battery are included. Many useful functions include: silent alarm, pager on/off,
backlight on/off, auto sleep set, alarm and time set, selectable scroll speed, move to memo, delete one
or all messages, lock messages, 4 selectable beep sounds, 8 selectable melodies, plus vibration and
sleep mode settings.

Figure 29. Arial Pager

Specifications: Arial Pager

Physical and Mechanical Dimensions: 2.5 x1.75 x 0.75 in (6.35 x 4.45 x1.9 cm

Weight: 1.9 oz (54 g); 2.5 0z (69 g) with belt clip

Input Frequency 457.6 MHz

Power 1 AAA battery, low battery alert

Display 4-line, backlit, zoom mode, date/time, battery level
Operation 3 buttons: Function, Select, Read

Attachments Supplied - Belt clip, lanyard, safety chain
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Alert Modes Beep, Vibrate, Melody, Sleep
Certification and Regulatory UL2560
Compliance

Arial Software Components

This section describes the Solution’s software components.

Arial Software

The Arial system is the next evolution of wireless nurse call, giving Assisted and
Independent Living Communities an advanced wireless platform for the safety and
security of their residents and the ease of use for their staff and caregivers. The Arial’
system incorporates the following key functionality:

*  Wireless communication platform for simple, cost effective, and flexible
deployments

* Consolidated event management, with alarm queues, dynamic maps, and
intelligent notification and messaging tools

* Advanced reports engine for tracking response times, compliance reporting &
resident system usage, with scheduled reports and automatic forwarding to email

* Event notification to mobile devices, overhead signs, and pagers

The Arial solution delivers several key benefits to senior living organizations:

* Improved performance: tracks response times & patterns across shifts to drive
higher levels of care

* Higher efficiency: pushes information directly to staff for efficient workflow

* Better resident experience: enables residents to call for help at any time.

The Arial system is designed to capture alarms and calls for help from wireless fixed
call stations. These alarms are displayed in the Arial software and optionally can be
sent directly to staff via a mobile app on a smart device, pagers or displayed on
overhead signs.

NOTE: The Arial system supports up to 3000 call points, but the number of
alarms that a Call Notification Station can display at once varies depending
on system settings and hardware. Once the number of active alarms
increases where they cannot all be displayed on a screen, a scroll bar
appears to enable viewing of the additional alarms. Alarms are sorted by
Category (highest priority on top) then by age (oldest on top).

Larger facilities use multiple Call Notification Stations to display alarms.
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Alarm points can be assigned to zones that match different areas of
responsibility covered by each Call Notification Station. This allows the
alarms that are relevant and actionable for care staff to be easily available.

See the Arial Administrator Guide for additional information about using
zones.

AeroScout Location Engine (ALE)

The AeroScout Location Engine works with the Gateway GW-1000 to supervise the
server and sound a trouble signal when an outage is detected.

Arial Mobile Application (Supplemental)

The Arial Mobile Application is a supplemental application designed to work
seamlessly with the Arial 900MHz Wireless Nurse Call System to provide senior living
caregivers with an innovative tool for handling emergency call alarms and
communicating collaboratively with their coworkers. The Arial Mobile Application is
packed with intuitive features to ensure community caregivers have visibility to all
relevant alarms, their status and who is responding.
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Solution Deployment Checklist

The following section is for STANLEY Healthcare and authorized Arial partner

installers.

Use the following checklist as a guide when deploying the Arial’ 900MHz Wireless
Nurse Call Solution.

IMPORTANT: Please read the important notes regarding backing up and
restoring before deploying the system. See Backing Up and Restoring.

Note: The order may vary according to the facility.

Steps Deployment Procedures

1 Set IP address of Arial and AES Server Network Interface that will be used for communication
with UL2560 Fundamental Equipment.

2 Arial software must be installed and configured according to the site.

3 Download, install and configure the AeroScout Location Engine.
See Deploying the AeroScout Location Engine.

4 Integrate Arial with the AeroScout Location Engine.
See Arial and ALE Integration.

5 Install Switches.

6 Install GW1000 device.

7 Install sirens (Model: 56108). See Installing and Configuring Sirens.

8 Configure Gateways to activate sirens. See Configuring Gateways to Activate Sirens.

9 Register and deploy repeaters. Give repeaters a description that describes where they will
be installed so they can be found later for servicing.

10 Register Call Stations to Arial with descriptions to indicate the room and location where they
will be installed.

" Install and Test Call Stations. See Deploying Call Stations.

12 Verify all Call Stations were tested by viewing Arial Device Activity Report and comparing to
room list.
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Assigning IP Address for PC to
Communicate on Fundamental

Network

1. Go to Control Panel of the PC where Arial Server and AES will be installed. This
procedure assumes the same PC will be used for both pieces of software.

2. Navigate to the IP Verd Network Properties Window

3. Choose Use the following IP address and enter IP address: 192.168.1.2 and
255.255.0.0 for the Subnet mask.

Internet Protocol Version 4 (TCP/IPv4) Properties X

General

You can get IP settings assigned automatically if your network supports
this capability. Otherwise, you need to ask your network administrator
for the appropriate IP settings.

(O Obtain an IP address automatically
(®) Lse the following IP address::

IP address: 192 .168. 1 . 2

Obtain DNS server address automatically

(®) Use the following DNS server addresses:

peerea s [ ]
[Jvalidate settings upon exit Adyanced...
[oc 1 conce

4. Click OK to apply the change.

Note: This IP address is needed to allow the AES to be able to configure
the GW1000 in later steps. The Gateway uses 192.168.1.1/78 as its default IP
address. If the customer’s network will be involved and these IP addresses

cannot be used permanently, they can be changed once the GW1000 is
added and a new IP address is assigned in a later step.
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Deploying the AeroScout Location
Engine

The Arial software communicates with a GW-1000 over a dedicated call system
network.

The ALE consists of the following components:

* AeroScout Engine Server (AES): Designed to process and forward messages
between GW-1000 and Arial.

* AeroScout Engine Manager (AEM): Administration and configuration tasks for the
AeroScout Engine Server are centralized in the AeroScout Engine Manager. The
AEM is used to configure network communication with the GW-1000.

The Arial 9O0MHz Wireless fundamental components must be installed on
a separate and dedicated network.

Important ALE Solution Deployment Notes

* Mobile Units and other non-STANLEY Healthcare Wi-Fi components are not
supported

* An HA (High Availability) setup is not supported

* The Engine Server (AES) and Manager (AEM) can be installed on the same
machine as Arial

* The ALE must be licensed using the STANLEY Healthcare support portal. See
AeroScout Engine Deployment Guide for more detail

* All access points need not be added to the AES for S00MHz deployments

ALE Deployment Checklist

For full ALE deployment details refer to the following resources from the STANLEY
Healthcare knowledge base:

‘ KB # Document Name ‘

12271 AeroScout Location Engine 5.5.4 Deployment Guide

12274 Location Engine 5.5 MR1 for Non-Cisco Download

Use the checklist below as a guide during the AeroScout Location Engine deployment
process.
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Steps Deployment Procedures

1 Download the AeroScout Location Engine 5.5.4 MR1 software version for Non-Cisco.
2 Install the Engine Server (AES) and Engine Manager (AEM) on the same machine as
Arial Server.

Refer to the Location Engine Deployment Guide > Installing
AeroScout Location Engine in a Non-Cisco Environment & Installing AeroScout
Engine Manage sections.

3 Register the ALE in the STANLEY Healthcare support portal in-order to receive a
license.

4 Apply the license in the Engine Manager.

5 Configure the Engine according to the site’s infrastructure:

*  Setup Campus, Building and Floor
e Add Map
*  Mark 0.0
* Calibrate Map
* Apply Calibration
* Add Cells
Refer to the Location Engine Deployment Guide > Defining Maps section.

6 Configure the Gateway 1000 devices on the maps in the Engine. See
Adding and Configuring Gateways in Engine

7 Configure the ALE Collection Time and
SNMP Trap Interval. See instructions in
this document.

Configuring the ALE Collection Time

The ALE Collection Time determines how long the Engine Server will wait to receive
the location data for a tag. After this timeout, the Engine Server starts calculating the
location of the tag.

Collection Time in the AeroScout Engine Manager (AEM) must be configured to 500
msec.

1. Open the AeroScout Engine Manager (AEM).

2. From the Menu bar click on Configuration and select Server Parameters >
System Parameters in the submenu.
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F‘a AeroScout Engine Manager
File =Configuration View Actions Tools Help
+ Exit Playback Mode (]
: 120 0o BB @
Users »
. ected to 127.0.0
Client Parameters
Campus - MobileView Association
)
t Server Parameters » Systern Parameters
- E Main Bid ' Logger
« (0] Ei” Floor Asset Locator Filter
4 '|'# Main Floor [ID: 1] . ) .
[ Devices Tag Security Configuration 3

3. Select the General tab.

4. Under Location Reports — Collection Window set the Collection Window time to
500msec.

Systemn Parameters X

General | Devices | Filters | Wi-Fi Devices | SNMP | Partners

Location Repaorts - Collection Window

Collection Window time (msec) for unidirectional tags:  |500

Location

[] Support tags attached to vibrating assets

Campus - MobileView Association
[] Multi Site Enable

Tag's LF Sensitivity Configuration
[] Enable Tag's LF Sensitivity configuration in Device Properties dialog

R55I Threshold Configuration
[] Enable RSSI Threshold configuration in Access Point Properties dialog

5. Click OK.

SNMP Trap Interval

When a device is down, such as a dome light, a trap is immediately sent from the
Engine to Arial, and then resent every 5 minutes (Engine default value). This default
value needs to be changed, in the Engine Server’s PeProperties file, to every 60
seconds (4 cycles) for UL2560 deployments.

The following procedure is for Non-Cisco (Standalone) systems only:
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1. Stop the AeroScout Engine Server.

2. From the Engine Server PC, navigate to the AeroScout Engine folder: C:\Program

Files (x86)\AeroScout\AeroScout Engine
3. Locate and open the PeProperties.properties file.

4. Scroll down to [SNMP].

5. Set the ‘SnmpSendDevicesStatusCount’ parameter to 4 and save the file.

[ of shME check cycles between
snmpsendDevi cesstatusCount=4 |

#5ets the connection timeout. This tTi
TcpTransportConnectionTimeout=120000

6. From the Engine Server PC, navigate to the AesBackup folder: C:\Program Files

(x86)\AeroScout\AesBackup
7. Locate and open the PeProperties.properties file in the backup folder.
8. Scroll down to [SNMP].

9. Setthe ‘SnmpSendDevicesStatusCount’ parameter to 4 and save the file.

F of shME check cycles between
snmpSendbevi cesstatusCount=4 |

#5ets the connection timeout. This ti
TcpTransportConnectionTimeout=120000

10. Restart the AeroScout Engine Server.

Location Engine Map Configurations

The following steps must be completed in the Location Engine before continuing:

Make sure the facility and resident floors have been defined.

Browse [z] | Daia I Repositony i Info |
4 @ Site:
5 Campus 1
g Campus 2
[ "g Campus 3
4 Senior Living
4 ['L_] Resident Building
(1) Resident Floor

Make sure the GW1000 has been added to a map in the AES.
The map is a central element of the Wi-Fi based system. Maps are used to mark

the position of installed devices across the site and to monitor the Wi-Fi Devices
and Tags moving within the site. A map represents one floor or part of a floor. One
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floor may include several maps. For 900MHz systems, the facility floorplan maps
can be added directly into Arial.

See the Arial Administrator Guide for Version 10.6 MR1in the Knowledge Base
Article #12137 for additional details about adding maps in Arial.

Note: For 900MHz devices, adding facility floor maps to the AES is not
required, however one map which can be any .png, .bmp or jpg file with the
GWI1000 placed on it is required. The GW1000 is not used to receive call
point messages from 900MHz devices and is only used as a watchdog
appliance for the Arial Server.

11} Byatem Canbomation e e

Steps for Adding Maps in AES

1. An image file for the map must be saved to a known drive location on the machine
running AES, typically somewhere on the C: drive. A simple image file can be created in
Paint if a map is not available and saved on the system.

2. Open AEM and connect to AES by selecting the File menu, then Connect to AeroScout
Engine Server.

E.-Ia AeroScout Engine Manager

File Configuration View Actions Tools Helg
Connect to AesoScout Engine Server '
Logout

Download Recordings
Download Logs
Backup Configuration

Restore Configuration

Exit

3. Enter the Admin User Name and Password. If the AeroScout Engine Server (AES) is
installed on the same machine as the Arial hardware and the AeroScout Engine Manager
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(AEM), the Host Name / IP Address can be set to 127.0.0.1. If the AES is installed on a
different system, use the hostname or IP address of the other system.

E Connect to AeroScout Engine Server
User Name: |hdmin | I
Password: e

Host Name / IP Address: 127.0.0.1
Port: 1411

Remember me

| ok || cancel |

4. Add Campus, Building, Floor, and Map by right-clicking and selecting the option to add
each layer staring with Site under the Browse pane. The final layer will be Add Map.

r‘a AeroScout Engine Manager
File Configuration View Actions Tools Help

Templates Data Info m

Browse '? Repository

4 gpsite

4 @Campus

4 E Main Bld

(@) Mair
Collapse
‘ Add Map

Remove

Properties

Upload Device Firmware
Associate Device Template
Status All Access Points
Status All Devices

Properties All Access Points

Properties All Devices

5. Enter a Name for the Map in the dialog that appears, then click OK.

(3 Add Map X

Name: :Main Floor |

OK ‘ ‘ Cancel ]

6. Browse to the location where the map file was saved using the window that appears.
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[3 Open x
4 & » ThisPC » Pictures > v o Search Picture »p
Organize ¥ New folder =~ ™ @
A
@ OneDrive
—
I This PC ——
J 3D Objects 1 ‘ l
I Desktop ~
Camera Roll Saved Pictures Map Mapl
4| Documents
& Downloads
D Music
& Pictures
B videos
‘4= Local Disk (C)
- STANLEY (D:)
v
File pame: | Map1 «| Imagefiles (*.bmp;*.gif:"jpg,"j ~

7. The map is displayed in the large section of the window. Right-click on a location on the
map (typically the lower- left corner) and select Mark 0,0 from the menu that appears.

| Replace Map Image
Mark (0,0)

Calibration 3

Apply Calibration

Cancel Calibration

8. If using a real map, right-click at a point on the map image where you know the distance
to another point, otherwise just click anywhere on the map. Select Calibration > Calibrate
Distance from the menus that appear.

Replace Map Image

Mark (0,0) . ‘

Calibration b l Calibrate Distance
Apply Calibration | Calibrate Point
Cancel Calibration . |

9. If using a real map, click and hold to draw a line to a second point on the map where the
distance is known, otherwise just draw an arbitrary line on the map.
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E AeroScout Engine Manager
File Configuration View Actions Tools Help

ARQ@I @EL-@2008 BREGEH
T | 0w | e N

Browse ? Repository
4 st
4 EgCampus
 [E)Main Bl
(0.} Main Floor -

;9} System Configuration
e Coverage Analyzer

@A::url:ykﬂlym

@ Radio Map Generator H-

10. If using a real map, enter a Distance between the two points in meters in the dialog
window that appears, otherwise enter a typical distance like 50 meters. Click OK.

@ Distance Calibration X

Distance (m): |50.00

OK Cancel

1. Right-click on the map a final time, then select Apply Calibration.

Replace Map Image

Mark (0,0)

Calibration »
Apply Calibration

Cancel Calibration

12. Verify your map appears under the floor in the hierarchy under the Browse pane.
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% AeroScout Engine Manager
File Configuration WView Actions Tools Help

RAQEO BEOILN

Templastes |  Data | co
Browse ? Repository
4 @5“}9
4 @Campus
4 [ Main Bld

4 [ 0) Main Floor
| g Main Floor [ID: 1]
—

13. Right-click in the map then select Add > Add Cell.

| Add » Add Device
Edit Cells Add Access Point
Edit Masks Add Reference Point
Calibrate Map | Add Cell
Remove Map Add Mask
Map Properties |

14. Draw a cell around the perimeter of the map. Make sure to close the cell.

E AeroScout Engine Manager
File Configuration View Actions Tools Help

RAARO AELLOLE 0O BDBIEBQEMH

I N coveceio 27001 Main Fioor [ID: 17.1.0
| Browse ? Repository
HER 2
[MAC Address [DevieeType
D00CCCESSF31 GW1000/GW1200 e 1

Numbes of devices - 1
<

Q System Configuration
e Coverage Analyzer

=

@Aﬂ:cnmwhnlynsr

‘.@ Radic Map Generaior
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15. Click OK on the Cell Properties dialog box.
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[ Cell Properties

fcen 1

Name:
Cell Perimeter
The Positioning search area is defined by the Cell Perimeter:
Coordinates

# X Y

1 -0.24 4556
2 7872 4544
3 78.61 -0.93
4 -0.7 -0.58

Cell Members

Cell Members Non Members

<<Add

Remove >>

Only location reports from Cell members are used for location calculation inside the Cell perimeter:
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Arial and ALE Integration

The following section explains how to integrate Arial software with the AeroScout
Location Engine. The integration is done after the ALE deployment.

Applying the UL2560 License in Arial

Arial must be licensed for UL2560 to set defaults in the software to match
requirements for UL2560. The following procedure must be performed by an Arial
Administrator.

1. Install Arial and HPS Server on the PC that will act as the Arial server (if this has
not been completed already). Refer to the latest version of the Arial Software
Installation Guide for requirements and steps to install the newest version of
Arial.

2. An Activation Code and License File are required for this procedure. They are
generally supplied on a USB drive included with the system. Contact Technical
Support at 800-380-8883 if you need assistance locating these files.

3. Launch Arial and login as an Admin if needed. Go to System > System > Server,
then click Update License.

e Arial’

Home Reports  System

Arial  EventCategories System  Notesand Procedures TranspotReasons  Site Profle  UserDefined Fields  Server

@ Infrastructure \/

Save

'\g Users Server Information

) Healthcare Platiorm Server Demo Edition. Version 6.18.0
(=) Messaging System Code:
PCs: 1
U oros DB Server ROOFSIMBIXMARK
DB User hps
PC Name ROOFGIME
. Address: 192.168.1.2
B Tranemiters Operating Systern  Windows NT - Version 6.02
Total RAM 11993 M8

Working Path C:Program Files (x86)Healthcare Platform Servert

Fy
> Y

._ﬂ Apartments

3

F| Schedules

7
| ¢) Reminders
Connected to 0 Browser Client(s)

R, egrosic
NumberConnectedCliens Shutdown Wink
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4. A Check License window opens. Locate your Activation File and copy the
System Code and paste in the System Code area, then copy the Activation Key
and paste in the Activation Key area. When finished, click Activate

# Check Licenss

®
Ligense Info - -
System ID 0 SUSPENDED  [ays left. [ |
@ Products | Marmenance By Date:  [4796:2081
Edtior:
Liceran kfa:

Refrmsh
Actrwation

System Code: 3
Acwwation Key :

2 | |II | 2940707-1 2630373671 2601 JGE27-1001 34745 1-1243374007-1112959395

T teae |

C\Frogram Fiea G863 Hoakhcam Mlarfoms Sorvertpsa f

If a dialog appears prompting you to Restart Healthcare Platform Server, click OK,
but do not restart just yet.

Healthcare Platform Server x
The license file has been updated.
Please restart Healthcare Platform Server for the new settings
to take effect.

6. Click Browse next to Update License File and locate the .lic file for your system
with the provided license information, then click Open on the Open window.

4 |« STAMLEY (D) » UL256D License
Orgenize = Mew folder

& Onelrive

Datema Trpe
2 sk ARTOLic TR T s
¥ 30 Objects
[ Deskiop
< Documents
& Downloads
I husic
| Pictures
B videcs
e Lacal Disk ()
— STANLEY (D)
v < .
File name: 23731 7913.ic

< | License [*lic})

Dpen Cen
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7. Click Update.

‘? Check License

X
License Info
System ID: [zz7317913 || AcTive |
3 Products: |Aria| | Maintenance Expiry Date:  |7/14/2021
Edition: |Hea|thcare Platform Server (Professional) |
License Info; | Murse Call "
ALE
UL2560
Mobile App
Enhanced Locate
Mumber of locators: 439
Mumber of WG Blue Controllers: 99
Mumber of Third Party Interfaces: 8 Refrosh
W
Activation
System Code: 23737913
Activation Key : |1112941]?1]?—126383736?—1264}13662?-184]134?4‘31-1 243374007-1112959395 | Activate
Licensing / Updates
Update License File : | D:\UL2560 License’237317913lic
System ID: 237317913 Products : [ gz |
Maintenance Expiry Date :  |4/15/2031
License File Info: Number of locators: 453 ~
Murse Call
ALE
LIL2560
MOBILEAPP

WanderGuard BLUE
Enhanced Locate
Mumber of WG Blue Controllers: 59

v

Close

C:\Program Files {(x86)Healthcare Platform Serverspss ff

8. If a dialog appears prompting you to Restart Healthcare Platform Server again,
click OK, then click Close to close the Check License window.

9. Shutdown Arial by clicking on the main STANLEY Menu in the upper left corner
of the Arial window, then select Exit.

STANLEY.

Admit
Modify Screens
View ’
Language 4
About
Help

B0 Ext
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10. Restart the PC by clicking on the Windows Menu in the lower left corner of the
PC screen, then selecting Restart under the Power options.

e Administrator

[ Documents
3 Sleep
(M Shut down
o

Restart

Power

L Type here to search

11. Wait for the PC to shutdown and boot back up. Arial should load after a few
moments. Log in as an Admin if necessary, then navigate to System > System >
Server and verify UL2560 appears as a listed license item.

STARLEY. Arial

Home Reports | System

Arial  Arial Mobile  EventCategories System  MNotesand Procedures  TransportReasons  Site Pro
S System
v -

@ Infrastructure \/

Save

Users ;
39) Server Information

:Di M . Healthcare Platform Server Demo Edition, Version 6.18.0
- sssaging System Code:

PC's: 1
LU Zones MNumber of WE_B Blue Controllers: 89
Mumber of Third Parly Interfaces: 8
Third Party Inteface / WanderGuard ELUE / Nurse Call / ALE |/ Mobile App / Enhanced LocatEJ

. Arial
m Transmitters

DB Server: RS0OFIIMBIXMARK
DB User. hps
i : PC Name: ROOFG3MB
@ EENE e Address: 192.168.1.2
Operating System:  Windows NT - Version 6.02
L Total RAM: 11993 MB
i_.u RESIEEE Working Path: C:\Program Files (x86)\Healthcare Platform Servert

12. Click Home to return to the Main Arial Screen.

Configuring Arial for ALE
The following procedure must be performed by an Arial administrator.

1. Login to the Arial software.

2. Click on the System tab.

3. Select Infrastructure.
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4, Click on the ALE tab.
Home (700) Reports|5ystem I
.5‘ St Network Devices  \WanderGuard Controllers Cateways PagerSwatons 0 R3INetworks R3Centrollers Speciralink  FialdServer Tnl:T
ALE (0)
| Infrastructure ] Name
8 Users
(=3 M’mgw
LDZDHG! T
)
. Transmitiers Add
AT
Device Types
wlpamu
W3
5. Click Add.
Home (700) Reports System
0 Network Devices  \WanderGuardControllers Gateways PagerStatons 10 R3N rk R3C Sp link FieldServer TekTone ALE
s .ALE (0)
8 Users
U Messaging
LDZ:M:
+
. Transmitiers Add
AT
Device Types
l"JI‘JApam-unu
&9 rone
6. Under the General section perform the following:
a. Enter in the Description as ALE.
b. Enter in the IP Address of the ALE Server (use 127.0.0.1if AES is
installed on same machine as Arial Server software).
c. Enter in the Port (Default is 1411).
d. Enter in the User and Password for the ALE.
e. Check that system Status is Connected.
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f. Leave Event Configuration as is.

System
Hetwork Deeaces  ‘wiarder Guard Conpoliens  Calwwwys  Pager Stors K0 MiNeiecrs  RiConiolen  Specinlbek  Feliferew  Tekfose ALl

BLE e b 201 P2 14T 2301 {0 Comnecied
12703
1411
dedrien

| EvemCestbgoween ——— —
1] Remirden HhzzngDiense i Gararsin
¥ R Clpas
S Tespint ismel wi [ o |
i
7. Click Save.
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Adding and Configuring Gateways in
Engine

Gateways must be mounted and connected before continuing with this
section.

The following section explains how to add and configure Gateways in the Engine.
Refer to the AeroScout Location Engine Deployment Guide for more details.

Adding Gateway

1. Click on the Repository tab, then click on the Scan button.

% AeroScout Engine Manager
File Configuration View Actions Tools Help

RAQEI HEO| ==

Templates Data info__|[P®
Browse ? Repository
)& - @
MAC Address

2|D1 Scan Parameters L

2. Click on the Scan button on the Repository Scan Parameters dialog that
appears.

[® Repository Scan Parameters X

IP Address search range:

Last updated: Tuesday, April 13, 2021 3:57:23 PM T

Scan I | Save H Cancel

Deployment & Maintenance Guide 74



3.

4.

Arial Wireless Emergency Call Solution

After a moment, verify a new device with Device Type of GW1000/GW1200
appears in the Repository. Confirm the MAC Address matches the one listed on

the label on the back of your GW1000.

E AeroScout Engine Manager

File Configuration View Actions Tools

Help

Templates Data Info
Browse ? Repository
e @ )
MAC Address |D-wlce Type
[fooocccessrai GW1000/GW1200 |

Click OK on the Add Device dialog box.

QAARAO  EEO W

@ Add Device
Device Type: GW1000/GW1200
Device Template: No Template

OK

‘ [ Cancel
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5. A Device Properties dialog box appears. Uncheck the boxes for Enable Wi-Fi
Receiver 1 and Receiver 2 then click OK.

[] Device Properties
p

General Settings | Wi-Fi

Identification

Device Name 00:0C:CC:65:5F:31
Map: Main Floor [17_1_0]
Template Name: No Template

Positioning Parameters
Coordinates (meters): X 13726 | Y (2407 | Z |3.00
Netwerk Configuration

MAC Address: 00 | |O0C | |CC | |65 | |5F | 31

IP Address: 192)./168 .| 1 180 Port: 151
+/| Connected to Network

Device Parameters

Device Model: Unknown

[+#] Enable Device LEDs

Device Type: GW1000/GW 1200 "

Functional Modules

[] Enable Wi-Fi Receiver 1

Comment

o

A grey icon for the Gateway where you placed it on the map appears. Right-click
the icon and select IP Settings.

Ly

. Ping
00:0C:CC

Restart

IP Settings

Status
Enable »

Save As Template
Properties

Remove

7. A TCP/IP Settings dialog box appears. Enter an IP Address for the GW1000 that
will be unique on the network segment being used. When finished, click OK.
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Note: If you are continuing with 192.168.1.2 for the AES PC, then you can
change the last byte of the IP so it is no longer .178. This helps prevent
problems if another Gateway needs to be added in the future. If you will be
changing the IP address of the AES PC, then the IP Address, Subnet, and
Gateway need to match the requirements for the LAN you will be using.

@ TCP/IP Settings X

Device: 00:0C-CC:65:5F:31MD: 3 91
MAC Address: 000CCC655F31

Obtain an IP address automatically (DHCP)
® Use the following IP address

IP Address: 102 ]./168 /. 1 |.[780]
Subnet: 255].[2551. o |.] o
Gateway: 192 .18l 1 1.9

Listening Port: 15M
Destination Port: 12091

0K Cancel

8. The gateway should still appear in grey on the map. If required, change the IP
address of the AES PC now in the control panels.

9. To make sure the GW1000 is communicating, right-click on the GW1000 icon then
select Ping from the menu.

E [ Ping
00:0C:CC S

IP Settings

Status
Enable »

Save As Template

Properties

Remove
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10. A success dialog should appear. If it does not, repeat the steps above to verify

the IP address of the GW1000.

Ping

11. Click OK.
12. The Gateway is added.
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Installing Gateways

Position and mount each GW1000 in the site according to the site survey recommendations.
The attached Siren needs to be placed where caregivers can hear the alarm should a system
failure occur.

Mounting the Gateway on a Wall

The Gateway is shipped with a mounting template which can be used to measure the
holes for mounting the Gateway on a wall or to a sheetrock ceiling. The mounting plate
supplied with the Gateway is not required for wall mounting.

Use this template to mark the holes on a wall for mounting
the Controller without it's mounting adaptor

~
/ P 3
Level Line i Vi oY

" STANLEY

e 0 A

). =

Figure 30. GW1000 Mounting Template
(supplied with the Gateway)

—

Hold the template on the wall in the location you wish to mount the Gateway. Make
sure the template is level.

2. Mark the four holes for the screws through the template.

3. Remove the template.

4. Dirill the holes for the screws.

5. Anchor the screws into the wall, leaving 10mm of each of the screws exposed. Use
appropriate screws and or anchoring plugs.

6. Mount the Gateway with the STANLEY Healthcare logo facing up, onto the 4

screws. The Gateway's back panel has 4 mounting brackets for this purpose.

Note: Alternative mounting kits are available if the Gateway must be
mounted on a drop ceiling.

Deployment & Maintenance Guide 79





